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PREFACE

Thank you for purchasing Analog Devices, Inc. development software for

digital signal processing (DSP) applications.

Purpose of This Manual

The VisualDSP++ 5.0 Licensing Guide describes how to manage your
license for VisualDSP++ software. For users who purchase floating
licenses, this guide describes the VisualDSP++ Floating License Server.

This manual does not describe licensing versions of Visual DSP++ prior
to release 5.0. For information about older versions, refer to Help ->
Contents -> Assistance -> Software License Management. The
“Visual DSP++ License Installation Procedure” is also available on the
Analog Devices Web site on the “Upgrades Archives” page, available at:

http://www.analog.com/processors/tools/updates

Infended Audience

The primary audience of this book is anyone who works with
Visual DSP++, a licensed product from Analog Devices. It describes the
licensing options available and how to install, register, and validate your

license. This manual also includes troubleshooting information and FAQs

for licensing issues.

Visual DSP++ 5.0 Licensing Guide
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Manual Contents

Manual Contents

The VisualDSP++ 5.0 Licensing Guide consists of:

Chapter 1, “Licensing Overview”

Describes the Licensing Agreement, explains what's new in
VisualDSP++ 5.0, and introduces the various available licensing
options

Chapter 2, “Installing a Node-Locked License”
Details how to install a node-locked license

Chapter 3, “Installing a Floating License Server”
Details how to install floating licenses and set up the license server

Chapter 4, “Registering and Validating Your License”
Details the process of registering and validating your license in
order to make it permanent

Chapter 5, “Checking the Status of Your License”
Describes the status (as shown in the About dialog box) of each
type of VisualDSP++ license

Chapter 6, “Troubleshooting”
Gives advice on troubleshooting license error messages and answers
frequently asked questions

Chapter 7, “Licensing Support”
Gives details of how to contact Analog Devices regarding licensing
issues

Visual DSP++ 5.0 Licensing Guide
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What's New in This Manual

This is the first version of the VisualDSP++ Licensing Guide.

Information that was previously contained in multiple documents has
been collected and organized in this new manual. In addition, this docu-
ment contains frequently asked questions and answers to help you solve
your problems quickly.

Technical or Customer Support

You can reach Analog Devices, Inc. Customer Support in the following
ways:

* Visit the Embedded Processing and DSP products Web site at

http://www.analog.com/processors/technicalSupport

* E-mail tools questions to
processor.tools.support@analog.com

* E-mail registration, validation, and serial number questions to
processor.tools.registration@analog.com

e E-mail processor questions to
processor.support@analog.com (World wide support)
processor.europe@analog.com (Europe support)
processor.china@analog.com (China support)

* In the USA only, licensing enquiries can be made to the following
toll-free number

1-800-ANALOGD (800-262-5643)

Visual DSP++ 5.0 Licensing Guide xi
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Technical or Customer Support

* Contact your Analog Devices, Inc. local sales office or authorized
distributor

* Send questions by mail to:
Analog Devices, Inc.
One Technology Way
P.0. Box 9106
Norwood, MA 02062-9106
USA

For licensing support information, refer to “Licensing Support” on

page 7-1.
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Supported Processors

Visual DSP++ 5.0 supports the following Analog Devices, Inc. processors.

TigerSHARC (ADSP-TSxxx) Processors The name “TigerfSHARC”
refers to a family of floating-point and fixed-point (8-bit, 16-bit, and
32-bit) processors.

ADSP-TS101 ADSP-TS201

ADSP-TS202 ADSP-TS203

SHARC (ADSP-21xxx) Processors The name “SHARC?” refers to a
family of high-performance, 32-bit, floating-point processors that can be
used in speech, sound, graphics, and imaging applications.

ADSP-21020 ADSP-21060 ADSP-21061 ADSP-21062
ADSP-21065L ADSP-21160 ADSP-21161 ADSP-21261
ADSP-21262 ADSP-21266 ADSP-21267 ADSP-21362
ADSP-21363 ADSP-21364 ADSP-21365 ADSP-21366
ADSP-21367 ADSP-21368 ADSP-21369 ADSP-21371
ADSP-21375

Blackfin (ADSP-BFxxx) Processors The name “Blackfin” refers to a

family of 16-bit, embedded processors.

ADSP-BF522 ADSP-BF525 ADSP-BF527 ADSP-BF531
ADSP-BF532 ADSP-BF533 ADSP-BF534 ADSP-BF535
ADSP-BF536 ADSP-BF537 ADSP-BF538 ADSP-BF539
ADSP-BF542 ADSP-BF544 ADSP-BF548 ADSP-BF549
ADSP-BF561

Visual DSP++ 5.0 Licensing Guide
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Product Information

Product Information

You can obtain product information from the Analog Devices Web site,
from the product CD-ROM, or from the printed publications (manuals).

Analog Devices is online at www.analog.com. This Web site provides
information about a broad range of products—analog integrated circuits,
amplifiers, converters, and digital signal processors.

MyAnalog.com

MyAnalog.com is a free feature of the Analog Devices Web site that allows
customization of a Web page to display only the latest information on
products you are interested in. You can also choose to receive e-mail
notifications containing updates to the Web pages that meet your inter-
ests, including documentation errata against all manuals. MyAnalog.com
provides access to books, application notes, data sheets, code examples,
and more.

Registration

Visit www.myanalog.com to sign up. Click Register to use MyAnalog.com.
Registration takes about five minutes and serves as a means to select the
information you want to receive.

If you are already a registered user, just log on. Your user name is your
e-mail address.

Processor Product Information

For information on embedded processors and DSPs, visit our Web site at
www.analog.com/processors, which provides access to technical publica-
tions, data sheets, application notes, product overviews, and product
announcements.

X1V
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You may also obtain additional information about Analog Devices and its
products in any of the following ways.

E-mail questions or requests for information to
processor.support@analog.com (World-wide support)
processor.europe@analog.com (Europe support)
processor.china@analog.com (China support)

Fax questions or requests for information to
1-781-461-3010 (North America)
+49-89-76903-157 (Europe)

Access the FTP Web site at
ftp ftp.analog.comor ftp 137.71.25.69
ftp://ftp.analog.com

Related Documents

For information on product related development software, see these
publications:

VisualDSP++ 5.0 Product Release Bulletin

VisualDSP++ 5.0 Getting Started Guide

VisualDSP++ 5.0 User’s Guide

VisualDSP++ 5.0 Assembler and Preprocessor Manual
VisualDSP++ 5.0 C/C++ Compiler Manual for SHARC Processors
VisualDSP++ 5.0 Run-Time Library Manual for SHARC Processors

VisualDSP++ 5.0 C/C++ Compiler and Library Manual
for TigerSHARC Processors

VisualDSP++ 5.0 C/C++ Compiler and Library Manual
for Blackfin Processors
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VisualDSP++ 5.0 Linker and Utilities Manual

VisualDSP++ 5.0 Loader and Utilities Manual

VisualDSP++ 5.0 Device Drivers and System Services Manual
for Blackfin Processors

o  VisualDSP++ 5.0 Kernel (VDK) User’s Guide
*  VisualDSP++ 5.0 Installation Quick Reference Card

Throughout this manual and VisualDSP++ Help, tools manuals are
often identified by their titles, but without their software version
(that is, the 5.0 is not shown).

For hardware information, refer to your processors’s hardware reference,
instruction set reference (or programming reference), and data sheet. All
documentation is available online. Most documentation is available in
printed form.

Visit the Technical Library Web site to access all processor and tools man-
uals and data sheets:

http://www.analog.com/processors/manuals

Installed Technical Documentation

Installed documentation comprises the Visual DSP++ Help system,
software tools manuals, hardware tools manuals, processor manuals, the
Dinkum Abridged C++ library, and FLEXnet Licensing End User’s
Guide. You can search across the entire Visual DSP++ documentation set
for any topic of interest. For easy printing, supplementary .PDF files of
most manuals are also provided.

Each documentation file type is described as follows.

xvi
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File Description

.CHM Help system files and manuals in Help format

JHTM Dinkum Abridged C++ library and FlexLM network license manager software doc-

or umentation. Viewing and printing the . HTML files requires a browser, such as

CHTML Internet Explorer 6.0 (or higher).

.PDF Visual DSP++ and processor manuals in Portable Documentation Format (PDF).
Viewing and printing the . PDF files requires a PDF reader, such as Adobe Acrobat
Reader (4.0 or higher).

If documentation is not installed on your system as part of the software
installation, you can add it from the VisualDSP++ CD-ROM at any time
by running the Tools installation. Access the installed documentation
from the VisualDSP++ environment, Windows® Explorer, or the Analog
Devices Web site.

Accessing Documentation From VisualDSP++

From the Visual DSP++ environment:

* Access VisualDSP++ Help from the Help menu’s Contents,
Search, and Index commands.

* Open VisualDSP++ Help from context-sensitive user interface
items (toolbar buttons, menu commands, and windows).

Accessing Documentation From Windows

In addition to any shortcuts you may have constructed, there are many
ways to open VisualDSP++ Help or the supplementary documentation
from Windows.

Help system files (.CHM) are located in the Visual DSP++ software installa-
tion’s Help folder, and .PDF files are located in the Docs folder of your
VisualDSP++ installation CD-ROM. The Docs folder also contains the
Dinkum Abridged C++ library and the FLEXnet licensing documentation.

Visual DSP++ 5.0 Licensing Guide xvii
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Using Windows Explorer

e Double-click vdsp-help.chm, vdsp-help-black.chm,
vdsp-help-sharc.chm, or vdsp-help-tiger.chm, which serve as the
master Help system, to access all the other . CHM files.

* Double-click any file that is part of the Visual DSP++
documentation set.

Using the Windows Start Button

e Access VisualDSP++ Help by clicking the Start button and
choosing All Programs, Analog Devices, Visual DSP++ 5.0, and
Documentation. Then choose the documentation for the processor
family you want from the list.

Accessing Documentation From the Web

Download manuals at the following Web site:
http://www.analog.com/processors/manuals

Select a processor family and book title. Download archive (.ZIP) files, one
for each manual. Use any archive management software, such as WinZip,
to decompress downloaded files.

Embedded Processing & DSP Knowledge Base

Search all our technical documents—everything from application notes,
data sheets, questions and answers, to code examples, manuals and more.

Point your browser to the following Analog Devices Web site:
http://search.analog.com/DSPKB/home.aspx

Printed Manuals

For general questions regarding literature ordering, call the Literature
Center at 1-800-ANALOGD (1-800-262-5643) and follow the prompts.

xXVviil Visual DSP++ 5.0 Licensing Guide
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Hardware Tools Manuals

To purchase EZ-KIT Lite™ and In-Circuit Emulator (ICE) manuals, call
1-603-883-2430. The manuals may be ordered by title or by product
number located on the back cover of each manual.

Processor Manuals

Hardware reference and instruction set reference manuals may be ordered
through the Literature Center at 1-800-ANALOGD (1-800-262-5643),
or downloaded from the Analog Devices Web site. Manuals may be
ordered by title or by product number located on the back cover of each
manual.

Data Sheets

All data sheets (preliminary and production) may be downloaded from the
Analog Devices Web site. Only production (final) data sheets (Rev. 0, A,
B, C, and so on) can be obtained from the Literature Center at
1-800-ANALOGD (1-800-262-5643); they also can be downloaded from
the Web site.

To have a data sheet faxed to you, call the Analog Devices Faxback System
at 1-800-446-6212. Follow the prompts and a list of data sheet code
numbers will be faxed to you. If the data sheet you want is not listed,

check for it on the Web site.

Notation Conventions

Text conventions in this manual are identified and described as follows.

Visual DSP++ 5.0 Licensing Guide xix



Notation Conventions

Example

Description

Close command
(File menu)

Titles in reference sections indicate the location of an item within the
Visual DSP++ environment’s menu system (for example, the Close
command appears on the File menu).

{this | that}

Alternative required items in syntax descriptions appear within curly
brackets and separated by vertical bars; read the example as this or
that. One or the other is required.

[this | that]

Optional items in syntax descriptions appear within brackets and sepa-
rated by vertical bars; read the example as an optional this or that.

[this,..] Optional item lists in syntax descriptions appear within brackets
delimited by commas and terminated with an ellipse; read the example
as an optional comma-separated list of this.

.SECTION Commands, directives, keywords, and feature names are in text with
letter gothic font.

filename Non-keyword placeholders appear in text with italic style format.

Note: For correct operation, ... A Note provides supplementary infor-
mation on a related topic. In the online version of this book, the word
Note appears instead of this symbol.

Caution: Incorrect device operation may result if ...

Caution: Device damage may result if ...

A Caution identifies conditions or inappropriate usage of the product
that could lead to undesirable results or product damage. In the online
version of this book, the word Caution appears instead of this symbol.

Warning: Injury to device users may result if ...

A Warning identifies conditions or inappropriate usage of the product
that could lead to conditions that are potentially hazardous for devices
users. In the online version of this book, the word Warning appears
instead of this symbol.

XX
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1 LICENSING OVERVIEW

This chapter describes the Licensing Agreement, explains what's new in
VisualDSP++ 5.0, and introduces the various available licensing options.
The following topics are covered:

e “Introduction” on page 1-1
e “What’s New in VisualDSP++ 5.0” on page 1-4

* “Upgrading to VisualDSP++ 5.0 from Earlier Versions” on
page 1-6

* “Licensing Options” on page 1-7

* “Obtaining a License Serial Number” on page 1-11

Infroduction

This section contains the following topics:
e “Supported Platforms” on page 1-2
e “Licensing Agreement” on page 1-2

e “Using this Book” on page 1-3

Visual DSP++ 5.0 Licensing Guide 1-1
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Supported Platforms

The following platforms are supported:
*  Windows 2000® SP4
e Windows XP® Professional SP2 (or greater)
* Windows Vista' Business edition
« Windows Vista Enterprise edition
« Windows Vista' " Ultimate edition

@ Windows NT®, Windows 98, and Windows ME are not
supported.

@ Visual DSP++ 5.0 requires an Intel Pentium 32-bit processor
(or x86 compatible) that is 1 GHz or faster.

64-bit host processors (x64) and 64-bit Windows editions
are not supported.

The Visual DSP++ License Manager is also supported on:
e Windows Server 2003

If using Windows Vista with User Account Control enabled, refer to
Windows Vista Compatibility in VisualDSP++ 5.0 Development Tools
(EE-330), which is available from:

http://www.analog.com/ee-notes

Licensing Agreement

Visual DSP++ is provided under the terms of the VisualDSP++ Tools
License Agreement. To view the full agreement, refer to the
License Agreement.txt file located in the <install_path> folder.

1-2 Visual DSP++ 5.0 Licensing Guide
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Using this Book

If you are upgrading to Visual DSP++ 5.0 from an earlier release, read
“What’s New in VisualDSP++ 5.0” on page 1-4 and “Upgrading to
VisualDSP++ 5.0 from Earlier Versions” on page 1-6.

If you want to use a node-locked license, read:

* “Obtaining a License Serial Number” on page 1-11 for informa-
tion on obtaining a license if you do not have one yet

e “Installing a Node-Locked License” on page 2-1 for instructions on
how to install your node-locked license

e “Registering and Validating Your License” on page 4-1 for instruc-
tions on how to register and validate your license

* “Checking the Status of Your License” on page 5-1 for instructions
on determining the current status of an installed license

If you want to use a floating license, read:

e “Obtaining a License Serial Number” on page 1-11 for informa-
tion on obtaining a license if you do not have one yet

* “Installing a Floating License Server” on page 3-1 for instructions
on setting up a floating license server

* “Registering and Validating Your License” on page 4-1 for instruc-
tions on how to register and validate your license

e “Checking the Status of Your License” on page 5-1 for instructions
on determining the current status of an installed license

If you have a question about, or are having problems with, your license,
read “Troubleshooting” on page 6-1, which explains commonly encoun-
tered error messages and provides answers to frequently asked questions.
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What's New in VisualDSP++ 5.0

If you require assistance with any licensing issues, read “Licensing Sup-
port” on page 7-1, which lists Analog Devices contact details.

Further Reading

For information on FLEXnet licensing, see the FLEXnet Licensing End
User Guide, which is installed with both VisualDSP++ 5.0 and the

VisualDSP++ Floating License Server software.

In the VisualDSP++ 5.0 installation, this document is located in the
<install_path>\Docs\flex\ folder.

In the Visual DSP++ Floating License Server installation, it is located in
the <install_path>\LMSERVER folder.

Additional frequently asked questions and information on recently discov-
ered licensing anomalies can be found in the Embedded Processing and
DSP Knowledgebase on the Analog Devices Web site at:
http://www.analog.com/processors/knowledgebase

What's New in VisualDSP++ 5.0

Visual DSP++ 5.0 provides the following enhancements.

Support of MAC Address for Use as a Host ID

The MAC address is a unique number associated with the computer's net-
work card.

From Visual DSP++ 5.0 onwards, if you do not have a hard drive on your
machine (or when installing to a system that does not have a C:\ drive),

the MAC address is used by default as the host ID.

1-4 Visual DSP++ 5.0 Licensing Guide
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License Borrowing from the License Server

VisualDSP++ 5.0 now provides the ability to “borrow” floating licenses
from the server machine for a predetermined length of time. This is partic-
ularly useful if you are a laptop user and want to develop your application
when traveling, or when you are at home. Note that this feature requires
that the license server be running the latest release of the VisualDSP++
Floating License Server software. The VisualDSP++ Floating License
Server installer can be downloaded from the VisualDSP++ 5.0 Upgrades
Web page at:

http://www.analog.com/dsp/tools/updates

Support for Remote Desktop

You can now access VisualDSP++ through Remote Desktop (a Microsoft
application that allows you to access one computer remotely from another
computer) using both node-locked and floating licenses. Provided that
you can connect to your office’s network remotely (using VPN, or a
similar application), Remote Desktop allows you to use Visual DSP++

on your computer at work when logging in remotely from another
computer.

Remote Desktop is not supported when using Visual DSP++ 5.0
with a node-locked license string created by an earlier release.

For information on upgrading an older Ticense.dat file to version 5.0
format, refer to “Upgrading to VisualDSP++ 5.0 from Earlier Versions”
on page 1-6. If you encounter any problems, send you Ticense.dat file
to Analog Devices Registration Support at:
processor.tools.registration@analog.com
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Upgrading to VisualDSP++ 5.0 from
Earlier Versions

In Visual DSP++ 5.0, support has been added to use FLEXnet license
borrowing, to allow use of a MAC address as host ID, and to permit
node-locked licenses to work with Remote Desktop (see “What's New in
Visual DSP++ 5.0” on page 1-4 for further information).

These changes have lead to a modification to the format of VisualDSP++
license strings, and therefore validation codes. This means that when you
register your serial number and host ID, two validation codes will be
e-mailed to you. One is valid for VisualDSP++ 4.5 and earlier versions;
the other is valid for VisualDSP++ 5.0 and later versions. Ensure that you
install the appropriate validation code for the version of VisualDSP++ that
you are using.

When upgrading to VisualDSP++ 5.0 from an earlier release of the tools,
you can do either of the following:

* During installation of VisualDSP++ 5.0, choose to copy an existing
license.dat file into your VisualDSP++ 5.0 <install_path>\Sys-
tem folder, or do so manually once VisualDSP++ 5.0 has been
installed. This option will allow you to get up and running imme-
diately, but will mean that the new features mentioned above will
not be enabled.

* During installation of VisualDSP++ 5.0 choose not to copy an
existing 1icense.dat file into your VisualDSP++ 5.0
<install_path>\System folder. Instead, install your serial num-
bers, then re-register them, and re-validate them. See “Registering
and Validating Your License” on page 4-1 for further details.
This option will enable the new features mentioned above.

1-6
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If you do copy an existing 1icense.dat file from an earlier version of
Visual DSP++ during installation of VisualDSP++ 5.0 and later wish to use
any of the new features, you must move your 1icense.dat file out of the
way (renaming it to something like 1icense_45.dat so you can identify it
later if necessary), and then re-install your serial numbers, re-register
them, and re-validate them.

@ license.dat files created by Visual DSP++ 5.0 work with
Visual DSP++ 4.5 and VisualDSP++ 4.0. This may be useful if,

for any reason, you need to revert to an earlier version of the tools.

Licensing Options

Visual DSP++ licenses are architecture specific; a separate license is
required for each of the processor architectures (Blackfin, SHARC, and
TigerSHARC) supported by VisualDSP++.

Visual DSP++ licenses are version independent. Most serial numbers that
worked with previous versions of Visual DSP++ also work with

VisualDSP++ 5.0.

Licenses are issued in the form of a unique serial number and typically
take the following form:

¢ Full License AD[-xxx-XXX-XXXXXXX-XXX
¢ Evaluation License KIT-xxx-XXX-XXXXXXX-XXX
e Test Drive License T ST -xxx-XXX-XXXXXXX-XXX

In the list above, “x”' represents a digit (0 - 9).
This section contains the following topics:
* “Node-Locked Licenses” on page 1-8

* “Floating (Client-Server) Licenses” on page 1-10
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Node-Locked Licenses

Occasionally referred to as a “single user license” or a “per user license”,
a node-locked license is locked to the host ID of the host computer and
provides a single license “seat”. Once installed, Visual DSP++ will run
on that one machine only.

You may install and register the software on additional machines for your
exclusive use, but each request for registration will be handled by Analog
Devices on a case-by-case basis.

The three distinct types of available node-locked licenses (“Full Licenses”,
“Evaluation Licenses”, and “Test Drive Licenses”) are described next.
The debug sessions enabled by each type of license are summarized in

Table 1-1.

Table 1-1. Debug Sessions vs. Licenses

Full License Evaluation License Test Drive License
Debug Session (ADI serial number) (KIT serial number) (TST serial number)
EZ-KIT Lite Yes Yes No
Emulator Yes Yes Yes
90 days only 90 days only
Refer to the note below
Simulator Yes Yes Yes
90 days only 90 days only

Refer to the note below

Note: The initial 90-day period incorporates all the capabilities of a “full license”.
After 90 days (unless you have upgraded the license to a full license), simulator
and emulator connections become prohibited and user program size becomes limited.

Full Licenses

Occasionally referred to as an “unrestricted license” or a “permanent
license”, a full license (whether node-locked or floating) enables simulator,
emulator, and EZ-KIT Lite debug sessions.
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Once installed, a full license must be registered and validated within
30 days; otherwise, Visual DSP++ will become inoperable until it is
validated.

Evaluation Licenses

Occasionally referred to as an “EZ-KIT license” or a “demo license”,

an evaluation license is a permanent, but restricted license. An EZ-KIT
license incorporates an initial 90-day full license. Once the 90 days have
passed, the evaluation license becomes restricted, prohibiting simulator
debug sessions and emulator debug sessions and restricting the amount of
internal memory that is available for code (program memory).

Once installed, an evaluation license must be registered and validated
within 10 days; otherwise, VisualDSP++ will become inoperable until it is
validated.

Evaluation licenses may be installed only once per machine.
Therefore, back up your <install_path>\System\license.dat file.

Test Drive Licenses

A test drive license is a temporary license, currently issued for 90 days,
after which it expires and renders Visual DSP++ inoperable. This type of
license enables emulator debug sessions and simulator debug sessions only.

Test drive licenses do not require validation.

Test drive licenses can be installed only once per machine.
Therefore, back up your <install_path>\System\license.dat file.
Also, a test drive license cannot be installed if an evaluation license
for the same architecture is already installed (or has ever been
installed) on the same machine.
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Floating (Client-Server) Licenses

Floating licenses have two parts: a server, and a client. The Visual DSP++
Floating License Server manages the license pool stored on the server. One
serial number is installed on the server for each single seat or 5-seat pack-
age. In this model, there can be as many client installations as desired.
Each time a user starts VisualDSP++ on a client machine, one license is
“checked out” from the server. When the user exits Visual DSP++, the
license is returned (checked back in) to the server. As long as there are
available licenses on the server, clients can use VisualDSP++.

For example, assume that your license server is configured with

10 licenses, and you have set up 20 client machines in three labs. Any

10 developers may use Visual DSP++ concurrently. When the 11th devel-
oper tries to connect, an error is emitted. This type of configuration
permits the sharing of software resources in an environment that requires
more locations than developers.

As of VisualDSP++ 5.0, the FLEXnet license borrowing feature is
supported. Refer to “License Borrowing” on page 3-14 for details.

Only full licenses are available as floating licenses. Evaluation
licenses and test drive licenses are not available as floating licenses.

Single-Seat vs. 5-Seat Floating Licenses

Floating licenses are available in both the “single-seat” or “5-seat” bundle
options, where “seat” refers to the number of concurrent licenses that may
be checked out while using Visual DSP++.
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Obtaining a License Serial Number

This section contains the following topics:
e “Full Licenses and Evaluation Licenses” on page 1-11
e “Test Drive Licenses” on page 1-11
* “Locating License Serial Numbers Already Installed in

VisualDSP++” on page 1-12

Full Licenses and Evaluation Licenses

Full licenses and evaluation licenses may be purchased in the following
ways.

You can buy licenses directly from Analog Devices or from a local
distributor. Obtain information about Analog Devices sales offices and
local distributors in your area from the Analog Devices Web site at:
http://www.analog.com/salesdir/continent.asp

Depending on your location, you may also be able buy direct via the
Analog Devices Web site’s Buy Online facility at:

http://www.analog.com/commerce/index.html

When you receive your copy of VisualDSP++, you will find the “ADI” or
“KIT” serial number on a sticker affixed to the back of the CD sleeve

(package).

Test Drive Licenses

In order to receive a test drive license, you must register online at:
http://www.analog.com/testdrive

If you have registered for a Blackfin test drive license, a “TST” serial
number will be e-mailed to you when you click the Register button.
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Obtaining a License Serial Number

Otherwise, the “TST” serial number will be displayed on the next page,
when you click on Register.

Locating License Serial Numbers
Already Installed in VisualDSP++

To find the serial numbers of licenses already installed in VisualDSP++,
choose: Start -> All Programs -> Analog Devices -> Visual DSP++ 5.0 ->
Manage Licenses (or Start -> All Programs -> Analog Devices ->
VisualDSP++ Floating License Server -> Visual DSP++ License Manager
if using a floating license.
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2 INSTALLING A
NODE-LOCKED LICENSE

This chapter assumes that you have already installed VisualDSP++ 5.0
and have obtained a license serial number.

If you are upgrading to VisualDSP++ 5.0 from an earlier version,
read “Upgrading to VisualDSP++ 5.0 from Earlier Versions” on
page 1-0.

This chapter describes:
* “Opening the About Dialog Box” on page 2-2
* “Entering Your Serial Number” on page 2-3

@ This chapter does not cover the installation of the client license
part of a floating license. For information about installing client
licenses, refer to “Installing a Floating License Server” on page 3-1.
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Opening the About Dialog Box

To install a node-locked license, the serial number must be entered via the
Licenses page of the About dialog box (Figure 2-1), which can be accessed
in any of the following ways:

e From the Windows Start menu, go to All Programs ->

Analog Devices -> VisualDSP 5.0 -> Manage Licenses

* Start VisualDSP++ while pressing and holding down the Ctrl key
until the Session Wizard appears. Then click Licenses.

* From within the Visual DSP++ IDDE, choose Help ->
About VisualDSP++, and then click the Licenses tab.

[»] About HE

General Licenses |\k=m'ms| &.lppmll

Seial Number || Famiy | Status |

Host ID
new| pezE|| | M1

Figure 2-1. Licenses Page of the About Dialog Box

Also, when starting Visual DSP++ for the first time, if a “1icense.dat” file
has not been copied from an existing installation of VisualDSP++ during
the installation process, you will encounter the following message and be
prompted to install a license.

A valid Ticense could not be found. Click Yes to install a
license at this time. Click No to close VisualDSP++.
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Entering Your Serial Number

From the Licenses page of the About dialog box, enter your serial number,
as follows:

1. Click New.
The Install New License dialog box (Figure 2-2) appears.

Install New License HE

“r'ou are about b install a software license ta run YisualDSP++.

Fleaze zelect one of the following license types:

& Hode-Locked license or Test Drive license

' Client license

Drescription

Thiz licenze type allows you to uge the VisualDSP++ toolz on a single
computer. Please enter your serial number exactly az it appears on the
registration card, CD sleeve or web site.

Serial number: I

()8 I Cancel |

Figure 2-2. Install New License Dialog Box

2. Select Node-locked license or Test Drive license (default).

3. In Serial number, enter your serial number exactly as it appears,
including dashes.

4. Click OK.

The following (or similar) success message appears.
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VisualDSP++

i The serial number has been successfully entered.
: This license will expire in 30 days. You must
register your productto obtain a permanent license.

Figure 2-3. Success Message

®

A license.dat file has now been created in your
<install_path>\System folder.

If you are using Windows Vista and have User Account Control
enabled, the Ticense.dat file will be saved to your VirtualStore
directory instead:
C:\Users\<user_name>\AppData\lLocal\VirtualStore\Program
Files\Analog Devices\VisualDSP 5.0\System

For details, refer to Windows Vista Compatibility in VisualDSP++
5.0 Development Tools (EE-330), which is available from:

http://www.analog.com/ee-notes

At this time, your license will have been activated for a temporary
period only. Your newly installed serial number will appear on the
Licenses page of the About dialog box, with the following status,
depending on the type of license you have installed:

* ADI prefixed serial numbers display as
Not Validated (Expiring in 30 days)

* KIT prefixed serial numbers display as
Not Validated (Expiring in 10 days)

* TST prefixed serial numbers display as
Test Drive (Expiring in 90 days)

2-4
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An example appears in Figure 2-4:

[»] About 21=]

General  Licenses |\|’ersion5 I Support I

Serial Mumber Famil Status

ADI-256-256-25625256-256  Blackfin - Not Validated {Bxpiring in 30 days)

1 | ]

Host ID
New... | Hegister.. | Yaldate. ||£|

Figure 2-4. Serial Number Installed

In order to make your full license or evaluation license permanent,
you must validate it. You obtain the necessary validation code by
registering online.

If you do not validate your license during the temporary license
period, your license will cease to function until it is validated.
Refer to “Registering and Validating Your License” on page 4-1.
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3 INSTALLING A FLOATING
LICENSE SERVER

There are two parts to floating licenses: server and client. The server
manages the license pool stored locally on the server. The clients
“check-out” and return licenses to the server as needed, when
Visual DSP++ is started and exited.

This chapter describes all the steps required to install floating licenses.
First, the Visual DSP++ Floating License Server (version 2.00.7 or later,
when working with VisualDSP++ 5.0) and server license(s) are installed
on your server machine. Second, VisualDSP++ 5.0 and your client
license(s) are installed on your client machine(s).

This chapter also describes the FLEXnet license borrowing feature,
which is new to Visual DSP++ 5.0.

If you are upgrading to VisualDSP++ 5.0 from an earlier version,
read “Upgrading to VisualDSP++ 5.0 from Earlier Versions” on
page 1-0.

This chapter is organized as follows:
e “Server Machine” on page 3-2
e “Client Machine” on page 3-12

e “License Borrowing” on page 3-14
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Server Machine

There are two parts to the Visual DSP++ Floating License Server:
e VisualDSP++ License Manager
* FLEXnet (formerly called FLEXIm) LMTOOLS

Your floating license serial number is installed through the Visual DSP++

License Manager. A Windows service must then be configured and started
using FLEXnet LMTOOLS.

If you are installing the Visual DSP++ Floating License Server for the first
time, go directly to “Task 1B: Installing the Visual DSP++ Floating
License Server” on page 3-4.

If you are upgrading an existing installation of the VisualDSP++ Floating
License Server, first you must disable and uninstall this existing installa-
tion as described in “Task 1A: Disabling and Uninstalling an Existing
Visual DSP++ Floating License Server” on page 3-3, and then you must
install the new version.

Version 2.00.7 of the Visual DSP++ Floating License Server
is compatible with VisualDSP++ 4.0, Visual DSP++ 4.5, and
Visual DSP++ 5.0.

If you are using VisualDSP++ 3.5 for ADSP-21xx as well as
Visual DSP++ 5.0 for another architecture, refer to “Frequently
Asked Questions (FAQs)” on page 6-1 for advice, or contact
Support.
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Task 1A: Disabling and Uninstalling an Existing
VisualDSP++ Floating License Server

You must perform the following procedure if you are upgrading an
existing installation of the VisualDSP++ Floating License Server.
The procedure disables and then uninstalls the software.

Uninstalling the VisualDSP++ Floating License Server tools from
Add/Remove programs leaves your license.dat file, intact in the
<install_path>\LMSERVER directory. This means that you can simply
re-use your original Ticense.dat file and skip Task 2 below.

However, to take advantage of the new license borrowing feature
introduced in VisualDSP++ 5.0 and version 2.00.7 of the VisualDSP++
Floating License Server, you must move your existing 1icense.dat file
out of the way and re-install and re-validate your serial numbers. From
Visual DSP++ 5.0 onwards, license strings (and therefore validation codes)
have changed in format. This means that you will need to re-register all
your serial numbers and install the Version 5.0-compatible validation
codes sent to you.

For further details, see “Registering and Validating Your License” on

page 4-1.

@ Save your <install_path>\LMSERVER\Ticense.dat file to a safe
place before proceeding.

1. From the Windows Start menu, choose All Programs -> Analog
Devices -> Visual DSP++ Floating License Server -> FLEXnet
LMTOOLS.

The LMTOOLS window appears.
2. Click the Start/Stop/Reread tab and click Stop Server.
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. Close LMTOOLS.

. In the Windows Control Panel, open Add/Remove Programs and

uninstall VisualDSP++ Floating License Server (or VisualDSP++
License Manager Server, as it was named in earlier versions).

Task 1B: Installing the VisualDSP++ Floating License

Server

The following one-time procedure installs the VisualDSP++ Floating

License Server, consisting of the Visual DSP++ License Manager and
FLEXnet LMTOOLS.

1. Insert the Visual DSP++ CD-ROM into your PC’s CD-ROM drive

and navigate to the VisualDSP_FLS_2.00.7 directory (off the root).
- Or -

Download the “Visual DSP++ Floating License Server Installer”
from the VisualDSP++ 5.0 Upgrades Web page
http://www.analog.com/dsp/tools/updates,

navigate to the download target folder, and unzip the
VisualDSP_FLS_2.00.7.zip file.

. Run setup.exe.

The InstallShield wizard appears.

. Follow the prompts.

The wizard completes the Visual DSP++ Floating License Server
installation. The default installation path appears in Figure 3-1.

A client-license.dat file will have been created, ready for
installation on your client machine (see “Task 4: Installing a Client
License” on page 3-12).

3-4
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Installing a Floating License Server

Install Shield Wizard E
Start Copying Files
Fieview settings before copying files.

Setup has enough information to start copying the program files. 1F you want to review or
change any settings, click Back. If you are satisfied with the settings, click Mest to begin
copying files.

Current Settings:

Files will be placed in: :I
C:\Program Fileghdnalog Devices\YizualDSPALMSERVER

Installing the following:
WizualD SP++ Floating License Server 2.00.7

i o

| Frztal Shield

< Back Cancel |

Figure 3-1. InstallShield Wizard

4. Copy the client-1icense.dat file from the
<install_path>\LMSERVER directory to a shared network folder.

Ensure that it has read-only permissions and is accessible to the
“Everyone” group.

Task 2: Installing a Server License

If you are upgrading from an earlier release of the Visual DSP++
Floating License Server and still have your original Ticense.dat
located in the <install_path>\LMSERVER directory, you may skip
this task and go directly to “Task 3: Configuring and Starting
FLEXnet LMTOOLS” on page 3-8.

For further details, see “Task 1A: Disabling and Uninstalling an
Existing VisualDSP++ Floating License Server” on page 3-3.
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Perform the following procedure for each floating license serial number.
One serial number is installed for each single seat or 5-seat package.

1. From the Windows Start menu, choose All Programs ->
Analog Devices -> Visual DSP++ Floating License Server ->
VisualDSP++ License Manager.

The VisualDSP++ License Manager application appears
(Figure 3-2).

i Visual DSP++ License Manager v2.00.7 & B3

Serial Number | Family | seats | status [

Machine D ————
Mew. .. | Hegistery.. | alidate .. | 11111111

Figure 3-2. VisualDSP++ License Manager

2. Click New.

3. In Serial number, enter the serial number exactly as it appears,
including dashes.

4. Click OK.

Upon successful installation, a success message appears.

A license.dat file has been created and is located in your
<install_path>\LMSERVER folder.

If you are using Windows Vista and have User Account Control
enabled, the Ticense.dat file will be saved to your VirtualStore
directory instead:
C:\Users\<user_name>\AppData\lLocal\VirtualStore\Program
Files\Analog Devices\VisualDSP 5.0\System
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For details, refer to Windows Vista Compatibility in VisualDSP++
5.0 Development Tools (EE-330), which is available from:

http://www.analog.com/ee-notes

This new license is activated for a temporary period only. The newly
installed serial number will appear on the License page of the About
dialog box (Figure 3-3) and will have a status of Not Validated
(Expiring in 30 days).

i Visual DSP++ License Manager v2.00.7 & B3
Serial Number | Family | seats | stats
ADI-234-23423-234234-23 TigerSHA... 5 Server - Mot Yalidated (Expiring in 30 days)
E [
Machine D ————
Cloze | Mew. .. | Hegistery.. | alidate .. | 11111111

Figure 3-3. License Page Indicating an Installed Serial Number Expiring
in 30 Days

In order to make your full floating license permanent, you must validate
it. You can obrtain the necessary validation code by registering online as
described in “Registering and Validating Your License” on page 4-1.

If you do not validate the license within the temporary license
period, your license will cease to function until you validate it.
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Task 3: Configuring and Starting FLEXnet LMTOOLS

This section describes how to configure FLEXnet LMTOOLS to run
the Visual DSP++ Floating License Server as a Windows service and
how to set up the path information for your license files.

1. From the Windows Start menu, choose All Programs ->
Analog Devices -> Visual DSP++ Floating License Server ->
FLEXnet LMTOOLS.

The LMTOOLS window appears.

2. Click the Service/License File tab and click Configuration using
services. Refer to Figure 3-4.

LMTOOLS by Macrovision Corporation hitp-//www macrovision.com M= B3
File Edit Mode Help

Service/License File | System Settingsl Utilitiesl Start.-"Stop.-"F!ereadI ServerStatusI ServerDiagsI Canfig Servicesl Borrowingl

Services allow FLEXnet Servers to run in the background.

— Server List
" Configuration uzsing Licenze File

&' Configuration using Services

—

[T LMTOOLS ignores license file path envionment variables

Figure 3-4. LMTOOLS Service/License File Tab

3. Click the Config Services tab.

4. Set up the options (see Figure 3-5) as follows:
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LMTOOLS by Macrovision Corporation hitp-//www macrovision.com
File Edit Mode Help

[ [ x]

Service/License FiIeI System Settingsl Utilitiesl Start.-"Stop.-"F!ereadI ServerStatusI Server Diags  Config Services | Borrowingl

Save Service |
Remove Service |

Configure Service

Service Mame

IM y Service LI

Fath to the Imgrd.exe file

Path to the license file

fiog DevicestisualD SFALMSERVE R mgrd. exe _ Bowse |
|og DevicestVisualDSPALMSERVE Rtlicense. dat e |

Fath ta the debug lag file I\nalog Devices\WizualDSPALMSERVER WMyLog | Browse  View Log...l ek el

¥ Start Server at Power Up ¥ Use Services

Figure 3-5. LMTOOLS Config Services Tab

In Service Name, enter the name of the new service you want to
create (or select an existing service).

Add/modify the name and paths to the existing 1mgrd.exe file and
the 1icense.dat file. Also, provide a name (<your_name>.109) for
the log file, which will then be created if it does not already exist.

By default, FLEXnet LMTOOLS looks for a license file with a
.Tic extension. Files with a .dat extension (the extension used by
the Visual DSP++ License Manager) are also accepted. Simply
change the extension in the Files of Type field to License Files
(*.dat) when browsing for the file.

Ensure that both the Use Services option and the Start Server at
Power Up option are selected.

Click Save Services to save this service to the existing list.

5. Click the Start/Stop/Reread tab (see Figure 3-6) and select your

newly created service from the list.
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LMTOOLS by Macrovision Corporation hitp-//www macrovision.com M= B3
File Edit Mode Help

Service/License FiIeI System Settingsl Utiities ~ Start/Stop/Reread | ServerStatusI ServerDiagsI Config Servicesl Borrowingl

FLE*net licenze services installed on this computer

My Service

Start Server Stop Server FeRead License File

: ™ Foree Server Shutdown
Crhee] sl 26 | MWOTE: This box must be checked to shut down a license server

when licenses are borowed.

IServer Start Successful

Figure 3-6. LMTOOLS Start/Stop/Reread Tab

6. Click Start Server.

The following messages appear:
Server Starting.
Server Start Successful.

It may take up to a minute for the server to start.

7. Click the Service Status tab (see Figure 3-7), and then click
Perform Status Enquiry.

8. Review the server status, which should indicate success.

If there appears to be a problem, review the above procedure,
ensuring that you have followed it step-by-step.

If you have followed the procedure and problems persist, review
“Troubleshooting” on page 6-1. If you continue to have problems,
contact Support (see “Licensing Support” on page 7-1), attaching
your license.dat and client-1icense.dat files.
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LMTOOLS by Macrovision Corporation hitp-//www macrovision.com M= B3
File Edit Mode Help

Service/License FiIeI System Settingsl Utilitiesl Start/Stop/Fleread  Server Status | ServerDiagsI Config Servicesl Borrowingl

Helps to monitor the status of network licensing activities

Optio:

Individual Daemon I
Perfarm Status Enguiny Individual Feature l—

Server Mame I

-------- =
Status
Flexible License Manager status on Wed €/27/72007 13:Z§
[Petecting lmgrd processea. .. ]
License serwver status: EBedin-luanshya

License file{s) on sdin-luanshya: C:\Program Filesa\Analog —
DevicealViaual BSPATMSERVERY licenae dat: LI

IUsing Licenze File: C:\Program Filesh\analog Devices\isualDSPALMSERVERYicense. dat

Figure 3-7. LMTOOLS Server Status Tab, Showing Status
Notes

* An existing service cannot be overwritten. You can remove a service
via the Delete Service button located on the Config Services tab.

* Starting/stopping the server, performing a status enquiry, and
re-reading a Ticense.dat file may take up to a minute.

* Whenever a change is made to the 1icense.dat file, the file must
be re-read by FLEXnet LMTOOLS. You perform this action via
the Start/Stop/Reread tab.

* If you are running multiple versions of FLEXnet (formerly called
FLEXIm) for various products, see “Troubleshooting” on page 6-1.

e If your server or client machines are running a firewall, contact
Support as described in “Licensing Support” on page 7-1 for advice
on how to proceed.
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Client Machine

Client Machine

Perform the following procedure to install a client license on a
workstation.

Task 4: Installing a Client License

The client-1icense.dat file must be available on the server,
in a shared network folder that is accessible by all users.

1. On each workstation, install VisualDSP++ 5.0 from the CD

or Web download and install the latest update (if applicable).

The base release download and latest updates are available on the

Analog Devices Web site at:
http://www.analog.com/dsp/tools/updates.htm]

If you are upgrading both client and server software, the server
software must be upgraded first. Begin at “T'ask 1A: Disabling and
Uninstalling an Existing Visual DSP++ Floating License Server” on

page 3-3.

. From the Windows Start menu, choose All Programs ->

Analog Devices -> Visual DSP++ 5.0 -> Manage Licenses.
The Licenses page of the About dialog box appears.

. Click New.

The Install New License dialog box appears.

. Click Client License.

. Click the browse (...) button to open a browser, from which to

select the c1ient-Ticense.dat file.

p— OI‘ —
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Installing a Floating License Server

In License file, type the name of the server and the license file in
the form:
\\server_machine_name\<path_to_shared_network_folder>
\client-Ticense.dat

You can locate the “server machine name” on the server machine
via the Windows Start menu by choosing Settings -> Control
Panel -> System (or System Properties) -> Computer Name ->
<full computer name>.

6. Click OK.

The client-Ticense.dat file from your server machine will now
be copied to your client machine, renamed as 1icense.dat, and
saved to the <install_path>\Systenm directory.

General | Licenses |\|’ersion5 I Support I
Senzl Number | Famiy | Satus |
EDIN-SHANSHAN  Client USE_SERVER

Host ID
Fegrster.. | alidate.. | 11111111
oK |

Figure 3-8. Licenses Page Showing Installed License

@ If you are using Windows Vista and have User Account Control

enabled, the Ticense.dat file will be saved to your VirtualStore
directory instead:
C:\Users\<user_name>\AppData\lLocal\VirtualStore\Program
Files\Analog Devices\VisualDSP 5.0\System
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License Borrowing

For details, refer to Windows Vista Compatibility in VisualDSP++
5.0 Development Tools (EE-330), which is available from:

http://www.analog.com/ee-notes

@ If a license.dat file already exists on the client machine (in

<install_path>\System), a message indicates that the current
license.dat file will be renamed to 1icense.bak and the client
license will be copied to the client machine.

If you are trying to install both a client license and a node-locked
license on the same machine, refer to the relevant information in

“Frequently Asked Questions (FAQs)” on page 6-1.

License Borrowing

From VisualDSP++ 5.0 onwards, you can “check out” a floating license
from the server for a predetermined length of time.

While a license is actively being borrowed, the server license count is
decreased, effectively providing a full, node-locked license with a fixed
expiration date.

When the set borrowing time expires, the server automatically returns the
license to the available pool, and the borrowed license on your machine

expires, disabling use of VisualDSP++.

Licenses can be returned early to the server. This capability requires
that you are connected to the network.

To initiate license borrowing, return licenses early, check the status of
borrowed licenses or stop borrowing licenses, use the Imborrow utility
provided in the VisualDSP++ Floating License Server install at
<install_path>\LMSERVER. Further details can be found in the FLEXnet
Licensing End User Guide, described in “Further Reading” below.

@ When borrowing a license, use analogd as the vendor name.
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Installing a Floating License Server

Further Reading

For a more comprehensive overview of FLEXnet licensing, refer to the
FLEXnet Licensing End User Guide, which is installed along with both
VisualDSP++ 5.0 and the VisualDSP++ Floating License Server software.

In the Visual DSP++ 5.0 install, this document is located in the
<install_path>\VisualDSP 5.0\Docs\flex\ folder.

In the VisualDSP++Floating License Server install, it is located in the
<install_path>\LMSERVER folder.

Visual DSP++ 5.0 Licensing Guide 3-15



Further Reading
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4 REGISTERING AND
VALIDATING YOUR LICENSE

This chapter explains how to register your license serial number and
obtain the validation code required to make your license permanent.

These procedures apply to full licenses and evaluation licenses only.
Test drive licenses function for 90 days and then permanently
expire. These licenses cannot be validated.

This chapter contains the following sections:
* “Required Information” on page 4-1
* “Registering Your License” on page 4-4

e “Validating Your License” on page 4-5

Required Information

In order to register your license on the Analog Devices Web site, you must
have the following information:

e License serial number

e Host ID
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Required Information

License Serial Number

Visual DSP++ license serial numbers are typically of the form:
Full license ADI-xxX-XXX-XXXXXX-XX
Evaluation license KIT-xxx-Xxx-XXXXXX-XX

where “x” represents a digit (0 - 9).

“ADI” and “KIT” prefixed serial numbers are issued on stickers, located
on the back of the Visual DSP++ CD sleeve.

Refer to “Obtaining a License Serial Number” on page 1-11 for details
about obtaining a license serial number.

Host ID

FLEXnet licensing uses the host ID, an identifier unique to each com-
puter, to lock licenses to a particular machine.

Visual DSP++ takes the default value of the host ID as the volume (or disk)
serial number of the C:\ drive. From Visual DSP++ 5.0 onwards, if you do
not have a hard drive on your machine (or have a setup that results in your

machine not having a C:\ drive), the MAC address is used. The MAC

address is a unique number associated with the computer’s network card.

Finding the Host ID for a Node-Locked License

From the Windows Start menu, choose All Programs -> Analog Devices
-> Visual DSP++ 5.0 -> Manage Licenses.

The host ID appears in the bottom-right corner of the resulting dialog box
(Figure 4-1).
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Registering and Validating Your License

[»] About HE

General Licenses |\k=m'ms| &.lppmll

Seial Number || Famiy | Status |

Host ID
new| pezE|| | M1

Figure 4-1. Licenses Page Showing Host ID

Finding the Host ID for a Floating License

From the Windows Start menu, choose All Programs -> Analog Devices
-> Visual DSP++ Floating License Server -> Visual DSP++ License
Manager.

The host ID appears in the bottom-right corner of the resulting dialog box
(Figure 4-2).

i Visual DSP++ License Manager v2.00.7 & B3

Serial Number | Family | seats | status [

Machine ID
Mew. .. | Hegistery.. | alidate .. | 11111111

Figure 4-2. Licenses Page Showing Host ID
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Registering Your License

Registering Your License

You must register full license and evaluation license serial numbers online
in order to receive a validation code.

Registering a Node-Locked License

To register a node-locked license:

1. Click the Windows Start button. Then choose All Programs ->
Analog Devices -> Visual DSP++ 5.0 -> Manage Licenses.
The Licenses page of the About dialog box appears.

2. From the list of serial numbers, select the serial number of the
license that you want to register.

3. Click Register.

Your system’s default browser is launched, and opens the Analog
Devices product registration Web page.

4. Fill in the required fields and submit the form.

A validation code will be e-mailed to you shortly.

Registering a Floating License

To register a floating license:

1. Click the Windows Start button. Then choose All Programs ->
Analog Devices -> Visual DSP++ 5.0 -> Visual DSP++ Floating
License Server -> VisualDSP++ License Manager.

The VisualDSP++ License Manager application opens.

2. Select the “ADI” prefixed serial number of the license that you
want to register.
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Registering and Validating Your License

3. Click Register.

Your system’s default browser is launched, and opens the Analog
Devices product registration Web page.

4. Fill in the required fields and submit the form.

A validation code will be e-mailed to you shortly.

Validating Your License

You must validate your license in order to make it permanent.

From Visual DSP++ 5.0 onwards, license strings (and therefore validation
codes) have changed in format. Consequently, when registering your serial
number and host ID, two validation codes will be e-mailed to you. One is
valid for VisualDSP++ 4.5 and earlier versions, and the other is valid for
VisualDSP++ 5.0 and later versions.

Ensure that you install the appropriate validation code for the
version of Visual DSP++ you are using. If you try to install the
wrong version, you will get the following error message

(Figure 4-3):

Visual DSP++ |

The validation code that you entered is invalid.
Pleass re-enter the cods, ensuring that vou type
the code EXACTLY as you received it. It might be
helpful to copy-and-paste vour validation code
rather than typing it manually.

Figure 4-3. Message: Invalid Validation Code
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Validating a Node-Locked License

This procedure assumes that you have received a validation code via e-mail
as described in “Registering a Node-Locked License” on page 4-4.

To validate a node-locked license:

1.

Click the Windows Start button. Then choose All Programs ->
Analog Devices -> Visual DSP++ 5.0 -> Manage Licenses.

The About dialog box appears.
Click the Licenses tab.

Select the “KIT” or “ADI” prefixed serial number of the license
that you want to validate.

Click Validate.

The Enter Validation Code dialog box appears.

In Validation code, enter the validation code.

Tip: Prevent typos by copying-and-pasting the code string.
Click OK.

Upon successfully entering this validation code, a message indicates
that a permanent license has been created.

Figure 4-4 shows that the node-locked license has been validated.

Validating a Floating License

This procedure assumes that you have received a validation code via e-mail
as described in “Registering a Floating License” on page 4-4.

4-6
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Registering and Validating Your License

General  Licenses |\|’ersion5 I Support I
Serial Number | Famity | Status |
ADI-256-256-25625256-256  Blackfin Validated {Permanent}

e R R ”Homnnﬂﬂn
oK |

Figure 4-4. VisualDSP++ License Manager Showing a Validated
Node-Locked License

To register a floating license:

1.

Click the Windows Start button. Then choose All Programs ->
Analog Devices -> VisualDSP++ 5.0 -> Visual DSP++ Floating
License Server -> VisualDSP++ License Manager.

The License Manager application opens.

Select the “ADI” prefixed serial number of the license that you
want to register.

Click Validate.

The Enter Validation Code dialog box appears.

In Validation code, enter the validation code.

Tip: Prevent typos by copying-and-pasting the code string.
Click OK.

Upon successfully entering this validation code, a message indicates
that a permanent license has been created.

Figure 4-5 shows that the floating license has been validated.
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Validating Your License

i Visual DSP++ License Manager = B3

Serial Number | Family | seats | stams
ADI-256-256-258'256256-2569 TigerSHARC 5 Server - Validated (Permanent)

‘ | B

Machine ID
Cloze | Mew. .. | Hegistery.. | alidate .. | 11111111

Figure 4-5. VisualDSP++ License Manager Showing a Validated Floating
License

You must now run the FLEXnet LMTOOLS application and re-read the
license.dat file from the Start/Stop/Reread tab.

To start FLEXnet LMTOOLS, from the Windows Start menu, choose
All Programs -> Analog Devices -> Visual DSP++ Floating License Server
-> FLEXnet LMTOOLS.

See “Installing a Floating License Server” on page 3-1 for further details.
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5 CHECKING THE STATUS OF
YOUR LICENSE

This chapter describes each possible status for each type of Visual DSP++
license.

This chapter contains the following topics:
e “Viewing a License’s Status” on page 5-1
* “Node-Locked Licenses” on page 5-2

e “Client Licenses” on page 5-4

Viewing a License’s Status

To view the status of node-locked licenses, from the Windows Start
menu, choose All Programs -> Analog Devices -> Visual DSP 5.0 ->
Manage Licenses.

To view the status of floating licenses, from the Windows Start menu,
choose All Programs -> Analog Devices -> Visual DSP++ Floating
License Server -> Visual DSP++ License Manager.

You will see a screen similar to Figure 5-1.
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Node-Locked Licenses

General  Licenses |\|’ersion5 I Support I
Serial Number | Famity | Status |
ADI-256-256-25625668-256  Blackfin Validated {Permanent}

e R R ”Hoamﬂﬂﬂn
oK |

Figure 5-1. Example: Licenses Page Showing a Validated License

Node-Locked Licenses

Node-locked licenses include:
e “Full Licenses” on page 5-2
e “Evaluation Licenses” on page 5-2

e “Test Drive Licenses” on page 5-3

Full Licenses

Full licenses have serial numbers that are prefixed with “ADI”. Each full
license has a status, as described in Table 5-1.

Evaluation Licenses

Evaluation licenses have serial numbers that are prefixed with “KIT”.
Each evaluation license has a status, as described in Table 5-2.
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Checking the Status of Your License

Table 5-1. Full Licenses -- Status Information

License Status

Description

Not Validated This is a full license that expires in X (initially 30) days because it
(Expiring in X days) has not yet been validated.
You must validate this license to enable permanent use
of VisualDSP++; otherwise, the license will expire and VisualDSP++
will become inoperable.
Validated This is a full license. It has been validated for permanent use of
(Permanent) Visual DSP++.
Not Validated This license has not been validated. The 30-day grace period is over,
(Expired) and VisualDSP++ is inoperable.

You must validate the license to enable permanent use
of VisualDSP++.

Table 5-2. Evaluation Licenses -- Status Information

License Status

Description

Demo - Full
(Expiring in X days)

where X is initially “10”

This is an evaluation license that expires in X (initially 10) days
because it has not yet been validated.

You must validate this license to enable permanent use of Visu-
alDSP++; otherwise, the license will expire and Visual DSP++ will
become inoperable.

Demo - Full
(Expiring in X days)

where X is initially “90”

This is an evaluation license. It has been validated for permanent
use of VisualDSP++. The initial 90-day period of full license
evaluation will expire in X days. The license will then become
restricted.

Demo

(Expired, Restricted)

This is an evaluation license. It has been validated, and the initial
90-day period of full license evaluation has expired.
You may use Visual DSP++ with EZ-KIT Lite debug sessions only.

Not Validated
(Expired)

This license has not been validated. The 10-day grace period is
over, and VisualDSP++ is inoperable.
You must validate the license to enable permanent use

of VisualDSP++.

Test Drive Licenses

Test drive licenses have serial numbers that are prefixed with “TST”.
Each test drive license has a status, as described in Table 5-3.
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Client Licenses

Table 5-3. Test Drive Licenses -- Status Information

License Status Description
Test Drive This is a test drive license that expires in X (initially 90) days.
(Expiring in X days) You may use VisualDSP++ with emulator or simulator debug

sessions only. When the 90 days are up, VisualDSP++ will
become inoperable.

Test Drive This test drive license has expired.

(Expired)

Client Licenses

When a client license is installed, its status is USE_SERVER. In addition, the
server name appears under Serial Number, and Cl1ient appears under
Family.

[»] About 21=]

General  Licenses |\|’ersion5 I Support I

Serial Mumber |_Famity | Status |
EDINSMSM Client USE_SERVER

Host ID
Fiegister, . | alidate). | 1111111
oK |

Figure 5-2. Example: Licenses Page Showing a Client License
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6 TROUBLESHOOTING

This chapter provides answers to common licensing problems and
includes the following sections:

*  “Frequently Asked Questions (FAQs)” on page 6-1
e “Error Messages” on page 6-16

For details on how to contact Support, refer to “Licensing Support” on

page 7-1.

Frequently Asked Questions (FAQS)

This section provides answers to:
* “General FAQs” on page 6-1

e “Visual DSP++ Floating License Server-Specific FAQs” on page 6-9

General FAQs

Question [ have lost my serial number. Where can I find it, or how do I get
a replacement?

Answer Firstly, note that serial numbers prefixed with “ADI” and “KIT”
are located on a sticker affixed to the back of the VisualDSP++ CD ROM
sleeve. In addition, you can locate already installed serial numbers by

going to Start -> All Programs -> Analog Devices -> Visual DSP++ 5.0 ->
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Frequently Asked Questions (FAQs)

Manage Licenses (or Start -> All Programs -> Analog Devices ->
VisualDSP++ Floating License Server -> Visual DSP++ License Manager
if using a floating license).

If you do not have Visual DSP++ installed and licensed currently, and have
lost your CD sleeve, e-mail Support with details of the person and com-
pany to whom the serial number was originally registered. For more
information, refer to “Licensing Support” on page 7-1

Question [ uninstalled VisualDSP++ due to a problem, and now when I'm
trying to reinstall my serial number I receive the message “The serial number

has already been used and can be installed only once”. What should I do?

Answer “TST” and “KIT” prefixed serial numbers may only be installed
once per machine.

If you have had to uninstall VisualDSP++ for any reason, note that unin-
stalling via Add/Remove programs in the Windows Control Panel leave
the <install_path>\System\license.dat file intact. Therefore, you can
simply copy and paste this file into the <install_path>\System folder of
your new instance of VisualDSP++. If you deleted all files in the install
path after uninstalling, check your recycle bin for the 1icense.dat file.

If you cannot find your original Ticense.dat file, contact Support with
the serial number that you are trying to reinstall. For more information,
refer to “Licensing Support” on page 7-1.

Back up your Ticense.dat file to prevent a similar problem.
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Troubleshooting

Question [ve received the message “The serial number has already been used
and can be installed only once”, but I've never installed this number before.
What’s going on?

Answer “TST” and “KIT” prefixed serial numbers may only be installed
once per machine. Possibly, someone else installed the serial number on
this machine in the past.

In addition, “T'ST” prefixed serial numbers may not be installed if a
“KIT” prefixed serial number for the same architecture is already installed
(or has ever been installed) on the same machine.

Contact Support with the serial number(s) in question, explaining the
p q p g
situation. For more information, refer to “Licensing Support” on

page 7-1.

Question [ve just installed a full license or evaluation license and now I get
a message telling me that the license will expire in X days. I thought these were
permanent licenses?

Answer When permanent licenses are installed, they initially have only a
“temporary” status. In order to make them permanent, they must be vali-
dated. Refer to “Registering and Validating Your License” on page 4-1 for
further details.
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Frequently Asked Questions (FAQs)

Question [ have just upgraded VisualDSP++ and the serial number I was
using previously is not accepted. Why?

Answer Certain serial numbers have been made obsolete over the years.

Contact Support with your current serial number, and you will be issued a
p Y y

replacement. For more information, refer to “Licensing Support” on

page 7-1.

Question [ need to transfer my license to a new machine (or, my hard drive
crashed and had to be reformatted). How do I register my license against a
new host ID?

Answer To register additional computers, install your serial number on
the new machine and register it online with the new host ID at the address
below. You will then be sent a validation code by e-mail. Installing this
validation code will make your license permanent.

Web form:
http://forms.analog.com/Form_Pages/DSP/products/visualDSPRegis-
tration.asp

If you receive a message about “...attempting to register more than the
allowed number of times...”, request a registration history update via
e-mail at:

processor.tools.registration@analog.com

Include the serial number(s) in question.
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Troubleshooting

Question How can [ find out my registration history? That is, how do I find
out which machines my serial number(s) are registered against?

Answer To request an up-to-date registration history, send an e-mail with
the serial number(s) in question to:
processor.tools.registration@analog.com

Question [ registered for a test drive license but I have not yet received it.
Why?

Answer If you registered for a test drive license for SHARC or Tiger-
SHARGC, the serial number will be displayed on the next Web page, after
clicking “Register”.

If you register for a Blackfin test drive license, the serial number will be
e-mailed to you.

In the event of a problem, contact Support. For more information, refer to
“Licensing Support” on page 7-1

Question [ have registered my evaluation license or full license, but have not
yet received a validation code via e-mail. Who should I contact?

Answer This may have occurred because your e-mail address was not
entered accurately into the Web form. Contact Support. For more infor-
mation, refer to “Licensing Support” on page 7-1.
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Frequently Asked Questions (FAQs)

Question [ve just upgraded to VisualDSP++ 5.0 and my existing validation
code isn’t accepted, even though I'm using the same machine that I registered
with. Why is this?

Answer From VisualDSP++ 5.0 onwards, license strings (and therefore
validation codes) have changed in format. This means that you cannot
install a validation code created for an earlier version of VisualDSP++ in
the 5.0 environment.

In order to receive a 5.0-compatible validation code, re-register your serial
number and host ID. You will then be e-mailed with two validation codes.
One is valid for VisualDSP++ 4.5 and earlier versions; the other is valid
for Visual DSP++ 5.0 and later versions. Ensure that you install the appro-
priate version.

For more information, refer to “Registering and Validating Your License”

on page 4-1.

Question The validation code that was e-mailed to me is being rejected.
What could be the problem?

Answer Firstly, note that validation codes are valid for a particular serial
number and host ID combination. Therefore, if you are trying to install
your serial number on a second machine, you will have to register it with
the new host ID in order to receive the appropriate validation code.

Also, from VisualDSP++ 5.0 onwards, license strings, and therefore vali-
dation codes, have changed in format. This means that when you register
your serial number and host ID, you will be e-mailed with two validation
codes. One is valid for Visual DSP++ 4.5 and earlier versions, and the
other is valid for Visual DSP++ 5.0 and later versions. Ensure that you
install the appropriate version.
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Troubleshooting

For more information, refer to “Registering and Validating Your License”

on page 4-1.

Question [ have been using a test drive license for 36 days and have now
bought an EZ-KIT Lite. My simulator debug session still works but I cannot
connect to the EZ-KIT debug session. Why not?

Answer EZ-KIT debug sessions are not supported by test drive licenses
(serial numbers prefixed with “T'ST”). You must install and register the
evaluation license serial number (prefixed with “KIT”), which can be
found on a sticker affixed to the back of the CD sleeve that came with
your EZ-KIT.

Question [ have an evaluation license and was working with an
emulator/simulator debug session until today, when I started receiving error
messages. Why can't I connect to my emulator/simulator debug session any

P
more:

Answer An EZ-KIT license incorporates an initial 90-day full license.
Once the 90 days have passed, the evaluation license becomes restricted,
prohibiting simulator and emulator debug sessions and restricting the
amount of internal memory that is available for code (program memory).
Refer to “Licensing Overview” on page 1-1 for further details.
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Question ['m getting errors when trying to use VisualDSP++ with Remote
Desktop. What could be the problem?

Answer Contact Support with full details of the problem, attaching your
license.dat file(s) if e-mailing. For more information, refer to “Licens-
ing Support” on page 7-1.

Question ['m running VisualDSP++ on Windows Vista and having some
problems with my license. I can’t find the license.dat file my colleague
installed. What’s going on?

Answer With the release of Windows Vista, Microsoft has introduced a
new security feature called User Account Control (UAC). UAC is a frame-
work that, when enabled, provides a more secure operating environment
for the user, which prohibits modification of critical system directories
and files. One of these directories is the Program Files directory into
which VisualDSP++ is installed when selecting the default setup options.

Licenses in VisualDSP++ are stored in a file called 1icense.dat located
within the System directory of your Visual DSP++ installation folder.
When installing a new license with UAC enabled, changes to the
Ticense.dat file will be redirected to the current user’s VirtualStore
directory. Because VirtualStore directories are specific to each user, this
has the added side effect that other users on the machine will not have
access to these licenses when using Visual DSP++.

To solve this, manually copy the Ticense.dat file from the first user’s
VirtualStore directory into the <install_path>\System directory. The
VirtualStore will be located in:

C:\Users\<user_name>\AppData\local\VirtualStore\Program
Files\Analog Devices\VisualDSP x.y\System
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Troubleshooting

where <user_name> is the name of the user who originally installed the
license, and x.y is the version of VisualDSP++ into which the license was
installed.

For details, refer to Windows Vista Compatibility in VisualDSP++ 5.0
Development Tools (EE-330), which is available from:

http://www.analog.com/ee-notes

VisualDSP++ Floating License Server-Specific FAQs
Question The LMTOOLS are asking for a *.lic file, but can’t find one. Why

not? ['ve already installed my serial number.

Answer The LMTOOLS application accepts license files with both the
.Tic and .dat extension. By default, when browsing for a license file,
LMTOOLS looks for files with a . 1ic extension. Simply change the “Files

of type” field to the .dat extension and you should find your Ticense.dat
file.

Question How do I check whether my FLEXnet service is running?

Answer This can be checked by starting the FLEXnet LMTOOLS and
clicking Perform Status Enquiry on the Server Status tab.

You can also check in the following way. Note the service name in the
Service Name field of the Config Services tab. Then go to Administrative
Tools in the Windows Control Panel and start the Services program. In
the list of services in the right-hand panel, check that the status of your
service is “Started”. If it is not, go to the Start/Stop/Reread tab in
LMTOOLS and click the Stop Server button and then click the Start

Server button.
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If this also fails, locate the debug log file indicated on the Config Services
tab of LMTOOLS and send it to Support. For more information, refer to
“Licensing Support” on page 7-1.

Question How do I use FLEXnet Licensing with more than one product?
Can I combine license.dat files?

Answer Yes, FLEXnet can manage licensing for multiple products, and
there are several ways to achieve this. Full details on using FLEXnet licens-
ing with more than one product is outside the scope of this document;
refer to the section entitled “Managing Licenses from Multiple Vendors”

in the FLEXnet Licensing End User’s Guide.
Should you require further assistance, contact Macrovision.

However, one method that has shown to be successful is to run the
FLEXnet server on one machine, running only one license server system.
In this case, ensure that each service run by LMTOOLS (including those
for products other than VisualDSP++) uses the same version of the
Imgrd.exe, and that 1mgrd.exe is the latest version installed.

This can be done by renaming the existing 1mgrd.exe in each vendor’s
FLEXnet (formerly named FLEXIm) folder, to move it out of the way, and
then copying in the latest version available to replace it. Alternatively, you
can change the Path to the Imgrd.exe field on the Config Services tab in
LMTOOLS for each service, so that it points to the most up-to-date
Tmgrd.exe file.
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Question How do I move my VisualDSP++ Floating License Server to a new
machine?

Answer Set up your new license server(s) and reinstall your client licenses
to point to this new server (as outlined in “Installing a Floating License
Server” on page 3-1). Re-register each serial number with the host ID of
the new server (“Registering and Validating Your License” on page 4-1).
Once you have done this, e-mail processor.tools.registration@ana-
log.com, requesting that the old machine(s) be removed from your
registration history. Be sure to include all relevant serial numbers and
host IDs. A registration history will be provided upon request.

Once your new server is up and running, disable the old server.

Question [ve upgraded to VisualDSP++ 5.0 and also need to upgrade
my Server License software. Will I still be able to use older versions of
VisualDSP++ with the new version of the server software?

Answer The VisualDSP++ Floating License Server is compatible with all
VisualDSP++ versions greater than and including Visual DSP++ 4.0.

If anyone on your network is working with the ADSP-218x or
ADSP-219x architectures and therefore needs to run Visual DSP++ 3.5
for 16-bit Processors, refer to the following question/answer, or contact
Support for assistance. For more information, refer to “Licensing Sup-
port” on page 7-1
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Question You state that the latest version of the VisualDSP++ Floating
License Server tools are not compatible with VisualDSP++ 3.5. However,
I need to use VisualDSP++ 3.5 for 21xx on the same network as I'm using
VisualDSP++ 5.0. Is there a way around this?

Answer There are a number of ways to do this; one example is given
below. If this does not cover your particular circumstance, contact Sup-
port. For more information, refer to “Licensing Support” on page 7-1

Example If you have an existing installation of VisualDSP++ 3.5 that uses
floating licenses, do the following:

1. Save the existing 1icense.dat file on your server to a safe place,

as a precaution.

. Disable and un-install your license server tools.

Note that un-installing the VisualDSP++ Floating License Server
tools (formerly know as the License Server Manager) from
Add/Remove programs leaves the install path, and your
license.dat file, intact in the C:\Program Files\Analog
Devices\VisualDSP\LMSERVER directory. This means that you
can re-use your original 1icense.dat file.

. Inyour license.dat file, comment out any license strings for any

architectures other than 21xx. This can be done by placing a “#”
at the start of each line; for example:

# FEATURE FRIO-FULL analogd 1.0 3-aug-2007 5 DDDDEEEEFFFF \
3 VENDOR_STRING=ADI-111-11111-111111-10

## INCREMENT FRIO-FULL analogd 1.0 permanent 5 AAAABBBBCCCC\
# VENDOR_STRING=ADI-111-11111-111111-10

Note: License strings can be found after the line:
## Begin FEATURE definitions’.
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4. Install the latest version of the Visual DSP++ Floating License
Server (currently version 2.00.7). Since your original Ticense.dat
file should still be in the C:\Program Files\Analog Devices\Visu-
alDSP\LMSERVER directory, the new tools should detect it, and any
further serial numbers installed through the VisualDSP++ License
Manager will be appended to it.

5. Re-install any SHARC, TigerSHARC, or Blackfin serial numbers
you wish to use. Be sure to register and validate them within 30
days.

6. Use FLEXnet LMTOOLS to configure and run the License Server.

See “Installing a Floating License Server” on page 3-1 for further details of
how to perform the above procedure. If you have problems with the above
procedure or have any questions, contact Support.

Question [ have to add additional licenses to the License Server. How do I do
this?

Answer The license server must be stopped first via the FLEXnet
LMTOOLS STOP/START/READ utility in the Configure Services win-
dow. Then follow the procedure as outlined in “Task 2: Installing a Server
License” on page 3-5. You must then restart the server.
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Question How do I install both a node-locked license and floating license on
the same machine?

Answer Follow this procedure.

1. Install and validate (if necessary) your node-locked license on your

client machine. Follow the procedure outlined in “Installing a
Node-Locked License” on page 2-1.

. Install and validate your floating license on your server machine.

Follow the procedure outlined in “Installing a Floating License
Server” on page 3-1.

. Copy the “# Begin FEATURE” section along with the node-locked

license string from <install_path>\System\license.dat on the
client machine to the end of the “# Begin FEATURE” section of the
\VisualDSP\LMSERVER\1icense.dat file on your server machine.

. Install the client 1icense.dat file part of your floating license on

the client machine by following the procedure outlined in “Install-
ing a Floating License Server” on page 3-1. This will replace your
node-locked 1icense.dat file with one that simply points to the
server. The existing 1icense.dat file will be renamed to
license.bak so that the information contained in it is preserved.

Note: Users on other client machines may receive an error message
regarding the node-locked license, should all floating licenses be in
use at the time they try to check one out.

For further information, refer to Q&A article QA0000555 in the
Embedded Processing and DSP Knowledgebase on the Analog
Devices Web site at:
http://www.analog.com/processors/knowledgebase
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Question ['m having trouble getting my floating license to work. My server
machine and/or my client machine has a firewall running. Could this be the

problem?

Answer Yes. You may need to make some changes to your floating license
setup in order to workaround this. Contact Support for further informa-
tion.

Question ['m installing a floating license and Corporate IS policies prohibit
shared network folders on my server machine. Are there any alternatives to
installing client licenses?

Answer Yes. An alternative method of installing a client license, which
doesn’t require the creation of a shared network folder or use of the Visu-
alDSP++ GUI, is to simply copy the
<server_install_path>\LMSERVER\client-Ticense.dat file to each client
machine’s <install_path>\System folder, and rename it to Ticense.dat.
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Error Messages

This section describes:
* “General Error Messages” on page 6-16

e “Visual DSP++ Floating License Server-Specific Errors” on

page 6-25
e “Warning Messages” on page 6-31

General Error Messages

General error messages include:
* “Errors Issued in Message Boxes” on page 6-16

e “Errors Issued in the Output Window or on the Command Line”
on page 6-22

Errors Issued in Message Boxes

Problem The serial number has already been used and can be installed only
once.

Solution The serial number you are trying to install has already been
installed on this machine. Note that evaluation and test drive serial
numbers may only be installed once per machine. In addition, test drive
serial numbers may not be installed if an evaluation license for the same
architecture has already been installed on that machine. For further infor-
mation, refer to “Licensing Overview” on page 1-1.
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Problem The serial number already exists. You will need to register the serial
number to receive a validation code. If you already have a validation code,
select the serial number and click the Validate button.

Solution VisualDSP++ found the serial number you entered; it is already
in the Ticence.dat file. If you have already installed that serial number
but have not yet registered it and received a validation code, follow the
steps outlined in “Registering and Validating Your License” on page 4-1.

Problem The serial number you entered is invalid. Please re-enter the num-
ber, ensuring that you type the number EXACTLY as shown on the

registration card.

Solution Ensure that you have typed in the correct serial number, exactly
as given. If you continue to have problems, contact Support, sending your
serial number and <install_path>\System\license.dat file, if avail-
able. For more information, refer to “Licensing Support” on page 7-1.

Problem The serial number you have entered is no longer valid. Please
contact Support (dsptools.support@analog.com or 1-800-analogd) to update
your serial number.

Solution VisualDSP++ has detected that the serial number you are trying
to install is no longer valid. Certain serial numbers have been made obso-
lete over the years. Contact Support with your current serial number, and
you will be issued with a replacement. For more information, refer to
“Licensing Support” on page 7-1.
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Problem VisualDSP++ has detected an invalid serial number. Please verify
the serial number is accurate with the one received with the VisualDSP+ +
product. If the problem persists, please contact Analog Devices' technical sup-
port at:

http:/fwww.analog.com/processors/technicalSupport/

Solution VisualDSP++ detected an invalid serial number in your
license.dat file. This error can occur when your 1icense.dat file con-
tains a once-valid serial number that has been made obsolete in later
versions of VisualDSP++. In this case, contact Support with your current
serial number and you will be issued a replacement serial number. For
more information, refer to “Licensing Support” on page 7-1.

Problem The serial number you entered is a Server serial number. Please run
the server license installation program to use this serial number.

Solution The serial number you are trying to install is a floating license
serial number. This must be installed through the separate Visual DSP++
Floating License Server application, rather than through the VisualDSP++
IDDE. Refer to “Installing a Floating License Server” on page 3-1 for
further details.
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Problem 7he validation code that you entered is invalid. Please re-enter the
code, ensuring that you type the code EXACTLY as you received it. It might be
helpful to copy-and-paste your validation code rather than typing it manually.

Solution VisualDSP++ detected that you entered an invalid serial num-
ber. Ensure that you have entered the correct validation code, exactly as
given.

Validation codes are valid for a particular combination of serial
number and host ID. If you are trying to install your serial number
on a different machine than the one you initially registered, you
will need a new validation code. Refer to “Registering and Validat-
ing Your License” on page 4-1 for further details.

From Visual DSP++ 5.0 onwards, license strings (and therefore validation
codes) have changed in format. Consequently, when registering your serial
number and host ID, two validation codes will be e-mailed to you. One is
valid for VisualDSP++ 4.5 and earlier versions; the is valid for

Visual DSP++ 5.0 and later versions. Ensure that you install the appropri-
ate validation code for the version of VisualDSP++ you are using,.

If you continue to have problems, e-mail processor.tools.registra-
tion@analog.com, identifying your serial number, validation code, and

host ID.

Problem The file does not contain valid client license information.

Solution VisualDSP++ detected an invalid client license file. Ensure that
you select the correct client-1icense.dat file.
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Problem The filename as entered could not be found. Ensure that the path is
correct and the file exists.

Solution VisualDSP++ detected that an invalid path or file name has been
entered for the location of the client-1icense.dat file. Ensure that the
path is correct and the file exists.

Problem Error: Cannot find a valid license path.

Solution VisualDSP++ was not able to find the given path to the
license.dat file. This indicates that the registry setting that stores the
location of your 1icense.dat file is incorrect, missing, or has been cor-
rupted. Try uninstalling, rebooting, and reinstalling VisualDSP++.

If the problem persists, contact Support for further assistance. For more
information, refer to “Licensing Support” on page 7-1.

Problem Failed to delete the license file: C:\Program Files\Analog
Devices\VisualDSP++ 5.0\System\license.dat

- Or -

Failed to copy the license file to: C:\Program Files\Analog Devices\Visu-
alDSP++ 5.0\System\license.client_backup

— Or —

Failed to open the license file: C:\Program Files\Analog Devices\Visu-
alDSP++ 5.0\System\license.dat

- Or -
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Failed to copy the license file to C:\Program Files\Analog Devices\Visu-
alDSP++ 5.0\System

Solution VisualDSP++ had a problem accessing the 1icense.dat file
located in the <install_path>\System folder. This can be caused by the
System folder, parent folders, or the 1icense.dat file itself having
read-only permission, by the file currently being held open by another
application, or by another disk/file access problem. Verify that the file and
folders have the proper settings to enable copying files and try again.

If the problem persists, contact Support for further assistance. For more
information, refer to “Licensing Support” on page 7-1.

Problem [Invalid license file. The license file may either be damaged or
missing. Please confirm that the following file exists:
C:\Program Files\Analog Devices\VisualDSP++ 5.0\System\license.dat

Solution VisualDSP++ had a problem accessing the 1icense.dat file
located in the <install_path>\System folder. This can be caused by the
System folder, parent folders, or the 1icense.dat file itself having
read-only permission, by the file currently being held open by another
application, or by another disk/file access problem. Verify that the file and
folders have the proper settings to enable copying files and try again.

This can also be caused by a 1icense.dat file that includes invalid
information.

If the problem persists, contract Support for assistance. For more
information, refer to “Licensing Support” on page 7-1.
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Problem Error: Failed to get a valid host id.

Solution VisualDSP++ was not able to get a valid host ID from your
computer, which is a modified version of the volume serial number. From
the C:\ drive, try running the “vol” command from the command prompt
to verify that you have a physical hard drive with a volume serial number.
If you do not have a hard drive (or if your setup results in you having no
C:\ drive), run “ipconfig /all” from the command prompt to verify that
you have a MAC address (the physical address of the network card). If you
have a volume serial number or a MAC address, try uninstalling, reboot-
ing, and reinstalling Visual DSP++ to see whether that fixes the problem.

If the problem persists, contact Support for further assistance. For more
information, refer to “Licensing Support” on page 7-1.

Errors Issued in the Output Window
or on the Command Line

Problem Error code: 0x80040112
Error description: Target not licensed for use

Solution This error is issued when trying to connect to a debug session.
Visual DSP++ was not able to find a license for the specific processor type
with which you are currently working.

This means that your license is not installed correctly or that you are
attempting to run a debug session for which you are not licensed.
Examples of the latter problem include attempting to run a SHARC
debug session when you only have a Blackfin license installed, or
attempting to run an EZ-KIT debug session when you only have a test
drive license installed.For more information, refer to “Licensing Over-
view” on page 1-1.
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Problem Error: cc1458:
Fatal Error: could not obtain license

Solution This error is caused by the compiler. The compiler could not
find a Ticense.dat file. Ensure that your license is correctly installed and
that it is for the same architecture as the target processor of the project you
are trying to build. Contact Support if you require further assistance. For
more information, refer to “Licensing Support” on page 7-1.

Problem [Error: eal 156]
Failed to get a license to run the assembler

Solution This error is issued by the assembler. The assembler could not
find a valid 1icense.dat file. Ensure that your license is correctly installed
and that it is for the same architecture as the target processor of the project
you are trying to build. Contact Support if you require further assistance.
For more information, refer to “Licensing Support” on page 7-1.

Problem Error [i1143
Failed to obtain license

Solution This error is issued by the linker. The linker could not find a
valid 1icense.dat file. Ensure that your license is correctly installed and
that it is for the same architecture as the target processor of the project you
are trying to build. Contact Support if you require further assistance. For
more information, refer to “Licensing Support” on page 7-1.
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Problem Error li1042
22742 (more than 22K) are used by code, while only 20KB are allowed under
EZ-KIT license restriction

Solution This error is caused by the linker. Evaluation licenses restrict the
amount of internal program memory that is available to the processor.
The exact amount that is available varies with each EZ-KIT Lite. If you
want to increase the available memory, upgrade to a full license. For fur-
ther information, refer to the EZ-KIT Lite manual.
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VisualDSP++ Floating License Server-Specific Errors

Visual DSP++ Floating License Server-Specific errors include:
e “Errors Issued in Message Boxes” on page 6-25

e “Errors Issued by FLEXnet Tools” on page 6-30

Errors Issued in Message Boxes

Problem The license manager has detected that a server license is being used
and that there is a problem communicating with the license server software.
This could be due to an out-of date version of the license server software or
there is not a network connection with the license server. Please check your
connection to the network or if your the server software is out-of-date update
the server tools using the latest license server installation.

The license server installer is available on a VisualDSP++ CD that matches
this release or it can be downloaded from:
http:/fwww.analog.com/processors/technicalSupport/toolsupgrades. html

Solution VisualDSP++ has detected a problem while communicating
with the VisualDSP++ Floating License Server. This error is usually
followed by a second error, headed “Flexible License Manager”, which
gives specific FLEXnet error codes, and which may help you narrow down
the problem when referring to the FLEXner Licensing End User's Guide.

Likely causes include:
* A problem with your connection to the network

* The instructions outlined in “Installing a Floating License Server”
on page 3-1 have not been followed correctly
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The version of the Visual DSP++ License Server Manager you are
using is not a recent enough version for the version of
VisualDSP++ that you are using. For VisualDSP++ 5.0,

version 2.00.7 or later must be installed.

The FLEXnet service is not running

For details on how to check this, refer to the FAQ entitled “How
do I check whether my FLEXnet service is running?”

A firewall is running on one or both machines. If so, contact
Support for information on working with FLEXnet licensing with
firewalls. For more information, refer to “Licensing Support” on

page 7-1.

More than one application that uses the FLEXnet (previously
known as FLEXIm) License Tools is running on the network.

If this is the case, review the FLEXnet Licensing End User’s Guide,
which has a section entitled “Managing Licenses from Multiple
Vendors”. Note that for most setups, only one version of
Imgrd.exe should be run on any network, and that version must be
the latest one installed. See also the FAQ entitled “How do I use
FLEXnet Licensing with more than one product?”.

Problem The serial number already exists.

Solution The VisualDSP++ License Manager has detected that the serial
number you are trying to install already exists in your 1icense.dat file.
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Problem T7he serial number entered is not a server serial number. Please
enter a serial number that was created for the server.

Solution The Visual DSP++ License Manager has detected that the serial
number you are trying to install is a node-locked license serial number.
The VisualDSP++ Floating License Server is not required for use with this
type of license.

Install your node-locked license through the VisualDSP++ IDDE. Refer
to “Installing a Node-Locked License” on page 2-1 for further details.

Problem The serial number you entered is invalid. Please re-enter the
number, ensuring that you type the number EXACTLY as shown on the
registration card.

Solution Ensure that you have typed in the correct serial number, exactly
as given. If you continue to have problems, contact Support, sending your
serial number and <install_path>\System\license.dat file, if available.
For more information, see “Licensing Support” on page 7-1

Problem T7he serial number you have entered is no longer valid. Please
contact Support (dsptools.support@analog.com or 1-800-analogd) to update
your serial number.

Solution The VisualDSP++ License Manager has detected that the serial
number you are trying to install is no longer valid. Certain serial numbers
have been made obsolete over the years. Contact Support with your cur-
rent serial number, and you will be issued with a replacement. For more
information, see “Licensing Support” on page 7-1
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Problem 7he validation code that you entered is invalid. Please re-enter the
code, ensuring that you type the code EXACTLY as you received it. It might be
helpful to copy-and-paste your validation code rather than typing it manually.

Solution The VisualDSP++ License Manager has detected that you
entered an invalid validation code. Enter your validation code exactly as
given.

Validation codes are valid for a particular serial number and

host ID combination. If you are trying to install your serial number
on a different machine than the one you initially registered, you
will require a new validation code. Refer to “Registering and Vali-
dating Your License” on page 4-1 for further details.

From VisualDSP++ 5.0 onwards, license strings (and therefore validation
codes), have changed in format. Consequently, when registering your
serial number and host ID, two validation codes will be e-mailed to you.
One is valid for VisualDSP++ 4.5 and earlier versions; the other is valid
for VisualDSP++ 5.0 and later versions. Ensure that you install the appro-
priate validation code for the version of VisualDSP++ you are using.

If you continue to have problems, e-mail processor.tools.registra-
tion@analog.com, identifying your serial number, validation code, and

host ID.

Problem [Invalid license file. The license file may either be damaged or miss-
ing. Please confirm that the following file exists:
C:\Program Files\Analog Devices\VisualDSP\LMSERVER\license.dat

Solution The Visual DSP++ License Manager had a problem accessing the
Ticense.dat file located in the <install_path>\LMSERVER folder. This can
be caused by the LMSERVER folder or the Ticense.dat file itself having
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“read only” permission, by the file currently being opened by another
application, or by another disk/file access problem. Verify that the file and
disk drive have the proper settings to enable copying files and try again.

This can also be caused by the 1icense.dat file including invalid
information.

If the problem persists, contact Support for further assistance. For more
information, see “Licensing Support” on page 7-1

Problem Failed to copy the license file to license.bak

Solution The Visual DSP++ License Manager was not able to create the
backup license file <install_path>\LMSERVER\Ticense.bak. This can be
the result of a read/write permission issue on the LMSERVER folder in the
Visual DSP++ install directory, a lack of disk space, the file attributes on
<install_path>\LMSERVER\1icense.dat being set to hidden, or another
disk/file access problem. Verify that the file and disk drive have the proper

settings to enable copying files and try again.

If the problem persists, contact Support for further assistance. For more
information, see “Licensing Support” on page 7-1

Problem Error: Failed to get a valid host id

Solution The VisualDSP++ License Manager was not able to get a valid
host ID, which is a modified version of the volume serial number, from
your computer. From the C:\ drive, try running the “vol” command from
the command prompt to verify that you have a physical hard drive with a
volume serial number. If you do not have a hard drive (or if your setup
results in you having no C:\ drive), run “ipconfig /all” from the command
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prompt to verify that you have a MAC address (the physical address of the
network card). If you have a volume serial number or a MAC address, try
uninstalling, rebooting, and reinstalling VisualDSP++ to see whether that
fixes the problem.

If the problem persists, contact Support for further assistance. For more
information, refer to “Licensing Support” on page 7-1

Errors Issued by FLEXnet Tools

ERROR: No such feature exists.

Feature: VDSP-DEBUGGER

Licensze path: Ci'\Program Files‘anzlog Devices\WisuzIDSP 5.0 0707131 -
"Systemlicenze. dat

FLEXnet Licensing efror:-5,417

For further information, refer to the FLEXnet Licensing End User Guide,

available at "www.macrovision.com™,

Figure 6-1. Example: FLEXnet Tools Error Message

For information on resolving errors issued directly by the FLEXnet
licensing tools (Figure 6-1), refer to the FLEXner Licensing End User
Guide, which is installed with both Visual DSP++ 5.0 and the Visu-

alDSP++ Floating License Server software.

In the Visual DSP++ 5.0 installation, this document is located in the
<install_path>\Docs\flex folder.

In the Visual DSP++ Floating License Server installation, this document is
located in the <install_path>\LMSERVER folder.
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Warning Messages

Warning messages include:
e “Warnings that Display in Message Boxes” on page 6-31
e “Warnings that Display in the Output Window or on a Command
Line” on page 6-32
Warnings that Display in Message Boxes

Problem The following serial number will expire in x days.

ADI-152-256-999999999-0000
— Or —

The following serial number expires today.
ADI-152-256-999999999-0000

Solution The given serial number has not yet been validated and will
expire in x days (or today). Refer to “Registering and Validating Your
License” on page 4-1 for further details.

Problem C:\Program Files\Analog Devices\VisualDSP++ 5.0\Sys-
tem\license.dat already exists.

The file will be renamed to license.bak and the new file will be added.

Solution The warning is issued when an existing 1icense.dat file has
been detected and is being replaced. This happens whenever you validate
an existing license or add a new license.
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Warnings that Display in the Output Window
or on a Command Line

Problem [Informational eal154]

License to use this tool will expire in x days

Solution The assembler has detected that your license will expire in x
days. If you have an evaluation license or a full license, register and vali-
date it.

6-32 Visual DSP++ 5.0 Licensing Guide



7 LICENSING SUPPORT

If you are still experiencing a problem after having tried to solve it using
the information in this guide, you can contact Analog Devices Customer
Support for assistance.

This chapter contains the following sections:
e “Information Required by Support” on page 7-1
e “E-Mail Support” on page 7-2
e “Telephone Support” on page 7-2

Information Required by Support

When contacting Support regarding a licensing issue, please send the fol-
lowing information if e-mailing (or have it available if telephoning):

* Version of Visual DSP++ and update (if any)
* License serial number(s) in question
* <install_path>\System\license.dat file (if available)

» Screenshots of encountered error messages

Visual DSP++ 5.0 Licensing Guide 7-1



E-Mail Support

Floating Licenses
If you are using a floating license, also provide the following information:

* Version of the Visual DSP++ Floating License Server
This is displayed in the title bar of the Start -> All Programs ->
Analog Devices -> Visual DSP++ Floating License Server ->
VisualDSP++ License Manager dialog box.

* <server_install_path>\<your_name>\license.dat file
* <server_install_path>\<your_name>\*.log file

* Screenshots of encountered error messages

E-Mail Support

You can obtain support via e-mail as follows.
Registration Support

Contact Registration Support if you have any problems with registering or
validating your license serial number, or if you have lost your license serial
number. Use the following e-mail address:
processor.tools.registration@analog.com

Processor Tools Support

For all other queries regarding Visual DSP++ licensing, contact Processor
Tools Support. Use the following e-mail address:

processor.tools.support@analog.com

Telephone Support

In the USA only, licensing enquiries can be made to the following toll-free
phone number: 1-800-ANALOGD (800-262-5643)
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